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Introduction
1.1
About this document In many cases problems or errors witnessed with OPUS have been accepted, and it has been tried to somehow get on with them. However, this attitude does not help to improve the general situation nor solves the specific problem. Therefore, report any single problem, error or OPUS system crash to the Bruker Optik software department. New ideas and suggestions for improvement are also welcome. For important information this document uses the following format:
i 1.2
The i provides important information given to the user to facilitate troubleshooting in specific application issues.
How to report errors? •
Send an e-mail to: [email protected]
•
Use the official OPUS error form available in the intranet (only internal): file://pia.optik.lan/Home/Groups/QM/Formblaetter/IRENS/FBSOI008.doc
1.3
Mandatory items to be reported in any case
Bruker Optik GmbH
•
Exact OPUS version with date
•
Operating system version
•
Detailed description of the last steps which have been done or tried to do
OPUS Error Reporting
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1.4
Further items to be reported Depends on the complexity of the problem. Several different types of problems or errors are distinguished: 1.
Complete operating system crash
2.
OPUS crash
3.
OPUS disappears
4.
Error message in OPUS
5.
OPUS interface freezes
The different types of problems or errors which may occur in connection with OPUS and their troubleshooting are described in chapter 2.
1.5
How to log errors in Windows 7 Any type of crash occurred in OPUS is generally logged by the Windows Error Reporting (WER) program. So-called dump files, which are more or less reports of what happened to the system at the moment before it failed, allow to save program information in the dump file, which can be useful for a later debugging. The dump file uses the minidump file format with the *.dmp file extension. If OPUS crashes and prior to its termination, the WER checks the dump file entries in the registry1 to determine whether a local dump is to be generated. In the affirmative, OPUS is terminated after the dump file has been generated. These dumps are configured and controlled independently of the rest of the WER infrastructure. You can make use of the local dump collection even if WER is disabled or if the user cancels WER reporting. The local dump can be different to the dump sent to Microsoft.
1. Windows database in which all pieces of information on software and hardware are stored.
6
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1.5.1
Defining WER as default program
i
Defining WER as default program for logging errors requires Administrator user rights. 1.
Open the Windows Start menu.
2.
Select the Run command.
3.
On the dialog that opens, enter regedit.
4.
Click OK to confirm.
5.
Select the following path for the registry parameters: ➣ HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\Windows Error Reporting\LocalDumps
6.
Bruker Optik GmbH
Enter the registry parameters described in chapter 1.5.2.
OPUS Error Reporting
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1.5.2
Registry parameters for global settings
Value
Description
Type
Default value
DumpFolder
The path where the dump files are to be stored. If you do not use the default path, the folder must contain ACLs that allow the crashing process to write data to the folder. For service crashes, the dump is written to service-specific profile folders depending on the service account used. For example, the profile folder for system services is: %WINDIR%\System32\Config\SystemProfile For network and local services, the folder is: %WINDIR%\ServiceProfiles
REG_E XPAND _SZ
%LOCAL APPDATA%\ CrashDumps
DumpCount
The maximum number of dump files in the folder. When the maximum value is exceeded, the oldest dump file in the folder is replaced by the new dump file.
REG_D WORD
10
Table 1.1:
8
Registry parameters for global settings
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Value
Description
Type
Default value
DumpType
Specify one of the following dump types: • 0: Custom dump • 1: Mini dump • 2: Full dump
REG_D WORD
1
Custom-DumpFlags
The custom dump options to be used. This value is used only when DumpType is set to 0. The options are a bitwise combination of the MINIDUMP_TYPEa enumeration values.
Table 1.1:
REG_D WORD
MiniDumpWit hDataSegs | MiniDumpWit hUnloadedModules | MiniDumpWit hProcessThr eadDatab
Registry parameters for global settings
a. http://msdn.microsoft.com/en-us/library/ms680519(v=VS.85).aspx b. In hex, this is the value 0x121.
Bruker Optik GmbH
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1.5.3
Registry parameters for application-specific settings
i
1.5.3.1
Application-specific registry parameters override the global settings. To create application-specific settings, you have to create a new key for your application (chapter 1.5.3.1).
Creating key 1.
Open the Windows Start menu.
2.
Select the Run command.
3.
On the dialog that opens, enter regedit.
4.
Click OK to confirm.
5.
Select the following path for the registry parameters: ➣ HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\Windows Error Reporting\LocalDumps\OPUS.exe
6.
Add the dump settings under the OPUS.exe key. ➣ If OPUS crashes, WER first reads the global settings, and then overrides any of the settings by using the application-specific settings.
1.6
How to log errors in Windows XP? Any type of crash occurred in OPUS is generally logged by Dr Watson. In some cases, however, other Windows programs are used to log system crashes. Windows XP, e.g. can be configured such that the Windows Error Reporting (WER) program acts instead of Dr Watson. In this case, a typical Windows error message pops up. It is possible to define Dr Watson as standard to trace errors in the form of so-called log files. The steps required are described in chapter 1.6.1.
10
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1.6.1
Defining Dr. Watson as log file standard 1.
Open the Windows Start menu.
2.
Select the Run command.
3.
On the dialog that opens, enter drwtsn32 -i.
4.
Click OK to confirm. ➣ A message pops up. The message confirms that Dr Watson has been installed as standard program to create log files.
5.
1.6.2
Click OK to confirm the message.
Error messages in Windows 1.
As soon as the error message is displayed, open the error report. ➣ The error processing is sent to Dr Watson which generates the corresponding log files.
2. 3.
Make a screen shot of the error report contents. Send the screenshot to [email protected]. ➣ Do not send the ’*\accomp.txt’ file to Bruker, as this file does not contain any usable data.
Bruker Optik GmbH
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Types of errors The following chapter describes the different types of problems or errors which may occur when working with OPUS.
2.1
Complete operating system crash
What happens?
Blue screen
Possible cause:
• Severe problems with the operating system • Perhaps a non-conforming driver
What about OPUS?
OPUS probably does not cause this problem as it is a user-mode program.
Information on the error:
• Look at the first two lines on the screen (mainly figures). • Look at the DLL list, written right below Name. • Check drivers recently changed, or new hardware components. • Remove drivers or look for more updated ones with the vendor.
Table 2.2:
Bruker Optik GmbH
Complete operating system crash
OPUS Error Reporting
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2.2
OPUS disappears
What happens?
• OPUS completely disappears from the screen. • Even the OPUS process disappears from the Windows Task Manager.
Possible cause:
• Any problem with the PC configuration • So-called Silent Process Exit: - normal, planned (and silent) exit, due to a normally executed (yet possibly unexpected) exit request for a component used within the OPUS process - abnormal exit (silent!), due to an unrecoverable multi-error problem • Interaction with other programs
Information on the error:
No information available at all, not even a message box notification.
What is to be done?
• Contact Bruker software department to clarify whether additional debug tools can be used. • Download the debugging tools for Windows (e.g. gflags.exe) from the following Microsoft Web site: http://www.microsoft.com/whdc/devtools/debugging/installx86.mspx • In case of Windows 7 and higher: activate the Silent Process Exit option; or configure an interactive debugger, e.g. via windbg -I
Table 2.3:
14
OPUS disappears
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Background information:
Very often the hang only occurs when the process is under load. The best approach is to attach a debugger to the process after it has hung (if you can reproduce the problem or remote debug), or create a process dump. A process dump is almost as good as a live debug in these cases, as the state does not change much over time; that is as good a definition of a hang as any other one.
Table 2.3:
2.3
OPUS disappears
Error message in OPUS
What happens?
OPUS still runs. Error message pops up.
Possible cause:
• Any temporary OPUS system error • Wrong procedure sequence • Missing files or methods
Information on the error:
Text written in error message
What is to be done?
Send a screenshot of the error message to: [email protected]
Table 2.4:
Bruker Optik GmbH
Error message in OPUS
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2.3.1
Error message in connection with ADIO/PROCESS
What is to be done?
Send the ADIO/PROCESS protocol log files to [email protected].
ADIO/PROCESS log file path:
• ADIO:  command. ➣  is a placeholder for the process ID (PID) of the program that has stopped responding. To obtain the PID of the program, open the Task Manager, and click the ’Process’ tab.
6.
Start the userdump  command. ➣ A file is generated with the ’*.dmp’ extension.
7.
Send the *.dmp file to [email protected], to perform post-mortem debugging.
2.5
Windows XP
2.5.1
OPUS crash
What happens?
OPUS will be closed automatically.
Possible cause:
Any severe OPUS system error, e.g. out of memory/resources
Information on the error:
Generally, Dr Watson pops up.
Table 2.7:
18
OPUS crash
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Standard log file path:
• [email protected].
Bruker Optik GmbH
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2.5.1.2
i
20
Generating a crash dump file
Usually, it is advisable to create a crash dump file (with user.dmp as file name). This type of file is very helpful in case of troubleshooting. The file requires, however, a lot of disk space. 1.
Open the Windows Start menu.
2.
Select the Run command.
3.
On the dialog that opens, enter drwtsn32.
4.
Click OK to confirm.
5.
On the dialog that opens, activate the Full option button to set the file display size.
6.
Activate the Create Cash Dump File check box.
7.
Send the crash dump file to [email protected].
OPUS Error Reporting
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Error during measurement If OPUS shuts down, or the interface freezes during measurement, a full report has to be generated (chapter 3.1), and the latest, still available measuring results have to be saved (chapter 3.2).
3.1
Generating full report The full report is a useful fault diagnostics tool. This report provides all the necessary information about the instrument configuration and complete spectrometer status. This report also includes error messages, internal and external data transfer as well as values of all relevant parameters. The full report is an important and - especially if a problem or failure has occurred - indispensable tool for fault diagnostics by service engineers.
3.1.1
Via the firmware page of the spectrometer
1
Table 3.8:
Bruker Optik GmbH
• Open the Web browser. • Enter the spectrometer IP address into the address entry field. • On the configuration page, click Service.
Generating full report
OPUS Error Reporting
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2
• Click the Full Report option. ➣
3
• On the File menu of the Web browser, click the Save as command. • Use the file extension *.htm. • Send the original htm file to [email protected]. Do not generate any screenshots or text files.
Table 3.8:
i
3.1.2
The current full report is displayed.
Generating full report
Save the full report immediately after a problem or failure has occurred. Otherwise, important information will be overwritten by newer entries.
Via the OPUS diagnostics page 1.
On the Measure menu, select the Optics Diagnostics command.
2.
On the dialog that opens, click the Send Report button. ➣ The report is sent to [email protected].
22
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3.2
Saving the latest measuring results
1
• Open the Web browser. • Enter the spectrometer IP address into the address entry field. • On the configuration page, click Service.
2
• Click the List of result data files option. ➣
3
• • • •
Table 3.9:
Bruker Optik GmbH
The measuring result list is displayed.
On the File menu of the Web browser, click the Save as command. Use the file extension *.htm. Click the Save button. Send the measuring result list to [email protected]. Saving the latest measuring results
OPUS Error Reporting
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Appendix The appendix contains additional information for systems with the special WinDebug tool installed. 1.
Open the WinDebug tool.
2.
Enter the following commands into the command line:
3.
•
LM (Enter)
•
KV (Enter)
•
R (Enter)
•
U (Enter)
•
DB (Enter)
On the Edit menu, select the Write Window Text to File command. ➣ A log file is created.
4.
Send the log file to [email protected].
For further information refer to: http://support.microsoft.com/kb/892277
Bruker Optik GmbH
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